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Top Menu 
 

       
 

 

1. The Top Menu (in the red box above left) at the top of the V7 Polling screen has a number of 

functions depending on what program area is open. The different program areas are accessed 

via the buttons on the left menu (above right). 

 

Machine List Area 
 

File Menu 

 

 
 

 

2. In the Machine List Area, the File menu displays the list of main program areas, which are the 

Machine List, Communications, Maintain, Reports, Most Recent, and Logout/Sleep. 
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 Logout/Sleep 

 

   
 

 

3. It includes a Logout/Sleep and Exit. The Logout/Sleep menu item on the drop down menu logs 

out the current user of the V7 software and returns to the login screen on the right. This is only 

available when Security is turned on. 

 

 Login 

 

    
 

 

4. To login, open the V7 software and click on the appropriate user name and a password entry box 

will open. Type the password into the entry box then click on the blue arrow (in the red box 

above) or hit the Enter key on the keyboard.  

5. The main V7 screen opens as on the right above. 

6. For user and password setup, see the Help Files topic: Administrator Rights and Security. 

 

 Exit 

 

7. The Exit menu item closes the V7 software. It can also be closed with the Exit button on the 

lower right of the V7 screen. 
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Tools Menu 

 

 
 

 

8. In the Machine List area, the Tools menu has the following items: Setup, Preferences, Clear 

Log Files, and Validate Tables. 

 

 Setup 

 

9. The Setup menu item takes the user to the Setup area of the software. 

 

 Preferences 

 

10. The Preferences menu takes the user to the Preferences area of the software. 

 

 

 
 

 

 Clear Log Files 

 

11. The Clear Log Files option removes files older than 7 days from the temporary folder. Click OK 

to close the screen. 

 

 Validate Tables 
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12. The Validate Tables menu item validates the Report Tables, Program Tables, and Support 

Tables and can delete the Index File if this option is check. Click on the Validate Tables menu 

item to open the screen above left.  

A. Choose the Machine from the drop down menu at the top. 

B. Choose Report Tables, Program Tables, or Support Tables to validate. 

C. If desired choose Delete Index File. 

D. All the appropriate tables will appear in the center. Check off some items or click the Select 

All button at the button of the screen to check off all listed items. 

E. The Clear Selected button can be used to uncheck all items. 

13. When all appropriate items are checked, click on the Begin Validation button to start the table 

validation process. 

 

 

         
 

 

14. The progress screen on the left above will open. 

15. When the validation process is successfully completed, the screen above right will appear. Click 

OK to proceed. 

16. The process can be repeated with the Program Tables and the Support Tables. 

17. To cancel the process, click on the Cancel Validation button. Note: The software will first finish 

the current table before canceling the validation. Large report tables will take a long time to 

validate and to cancel. 

18. Click the Close Form button in the lower right to exit the validation screen. 

 

Help Menu 

 

 
 

 

19. The Help menu at the top left of the main V7 screen contains the following items:  ? Help, Go To 

Meeting, and About. 
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 ? Help 

 

 
 

 

20. The ? Help menu item opens the Help files. 

 

 Go To Meeting 

 

 
 

 

21. The Go to Meeting menu item is a link from the Help menu, which in Version 7.3 Polling, has 

been added to make it easier for the user to connect to a GoTo Meeting® session with Tri-

Technical Systems support. The user should close or minimize all windows they do not want to 

be seen before starting. Click Go To Meeting to open the screen above. Please see the Help 

Files under Advanced V7 Polling Options. 

 

Maintain Area 
 

Communicate 

 

 

 
 
When in the Maintain area, another drop down menu is added – Communicate. 
 
 



6 
 

 
 
 
Depending on the program open under Maintain on the left menu, the top menu options change. Most 
have a save and send. For example in the Age Verification area, The Communicate drop down menu 
has Save Age Verify and Send Age Verify. 
 

Maintain Area – PLU 

 

PLU Tools 

 

    
 

 

22.  When in the PLU area, the Tools menu has the following items on the drop down menu:  Setup, 

Preferences, Clear Log Files, and Validate Tables. 
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PLU Tools 

 

 
 

 

23. When in the PLU area, under Maintain, the PLU Tools menu has the following items:  Print 

Barcodes, Mass Update, Mass Create, Verify, Fill Blanks With Register Defaults, Fill Blanks With 

Templates, Add Check Digit, Remove Check Digit, Strip Price Embedded Barcodes, Set Base 

PLU Template, Show PLU Margin Report:, Create AIMsi Inventory Items From PLUs, Update 

Selected AIMsi Inventory Items, and Show PLUs Not Linked To AIMsi Inventory. For a detailed 

look at these menu items, see the Help Files topic Advanced V7 Polling Options. Note:  

Naming conventions do vary based upon machine types. 

 

Communicate 

 

 
 

 

24. When in the PLU area under Maintain, the Communicate menu has the following options:  Save 

PLU, Save PLU Stock, Save PLU Stock (IRC), Save PLU Stock Minimum, Send PLU, Send PLU 

Changes Only, Send PLU Delete, Send PLU Stock, Send PLU Stock (IRC), Send PLU Stock 

Minimum, and Send PLU Stock Modify. See the Help Files under Advanced V7 Polling Options. 

Note:  Naming conventions do vary based upon machine types. 
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Reports Area 
 

Report Tools 

 

 
 

 

 Import Report from File 

 

25. From the left menu when Reports is picked, the Report Tools menu has the following options:  

Import Report from File, PLU Report Module, Custom Consolidation, TLog Export, and 

TLog Export Options. 

 

 

 
 

 

26.  The first option, Import Report From File, opens the Import Report File screen. Pick the file to 

import with the File Type drop down menu.  

 

Note: PC/POLL Transfer Files can be created automatically via scripted reports with the Transfer 

Export tab configures or they can be created manually via the Reports Export Text File button. 

 

Note: Casio FTP Report Files are created by Casio Register. 

 

 



9 
 

 
 

 

27. From the Select drop down menu, click the  button at right side of the entry box, an Open 

screen will appear, and then browse to the file report file to import. 

A. Check off Delete File After Successful Import to delete the files when done.  

B. Import Selected Files imports the files picked in Step 25. 

C. Select All Files will select all files in the File List to import. 

D. Clear Selected Files will unselect files highlighted in the File List. 

E. Remove Selected Files will remove all files that have been highlighted from the File List. 

28.  Click the Close button, when done to close the Import Report File screen. 

 

 PLU Report Module 

 

 
 

 

29. The PLU Report Module option opens the screen above. 
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30. The Report type can be set at General Item Report, Margin Report, or History. 

 

 

 
 

 

31. Set the Sort Type to By Item Code, By Description, By Amount, or By Quantity. 

 

 

 
 

 

32. Pick a Sort Order Ascending or Descending. 

 

 

   
 

 

33. Enter a Start Date by type it into the entry box or by clicking the down .button. A calendar will 

appear allowing the user to click on a date. The months of the year can be advanced or digressed 

by clicking on the back arrow  and the forward arrows .  

 

 

 
 

 

34. Enter an End Date the same way as a Start Date above. 
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35. To make the Range entry boxes active click in the check box then enter the machine range. Enter 

a PLU code range. 

 

 

 
 

 

36. Pick a Poll Type. 

 

 

 
 

 

37. Choose a Poll Area. 

 

 

 
 

 

38. Pick a type of filter. 

 

 

  
 

 

39. From the Store List, pick the appropriate store or stores. To pick all stores in the list, click the 

Select All button. To remove all stores from the list, click the Clear All button. 
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40. The Machine List works the same as the Store List above. Select one machine at a time by 

clicking on it or click on the Select All button to check off all machines in the list. To clear the 

entire list, click the Clear All button. 

 

 
 

 

41. Set the options needed then export to a TXT/CSV file, or Print to a PDF, RTF or to a Report Text 

File. 

 

 

 
 

 

42. To activate the Satellite List, use the drop down menu to pick Inclusive Register List or 

Exclusive Register List. Picking Inclusive Register List will cause the consolidation to include 

any reports that contain data from any of the selected registers. Picking Exclusive Register List 

will cause the consolidation to include only reports that contain data from the exact set of 

registers selected. 

 

 

 
 

 

43. The satellites can now be picked by clicking on them. The Select All button will check off all 

satellites in the list where as the Clear All button will remove all check marks from the list. 
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44. The Show Graph of Report option, which is available only on the History Report, will use the 

selections made on the PLU Report Module screen to create a graph of the report information. 

The graph will open after Step 48 if Show Graph of Reports is checked off.. 

 

 

  
 

 

45. The date range for each line on the report is set by the Time Interval (Days). In the example 

above, the Time Interval (Days) is set to “7” and is only available on the Item History Report. The 

first line of the report shows that the From Date is 12/21/2010 and the To Date is 12/27/2010, 

which is an interval of 7 days. 7 days data is combined for each line.  

 

 

 
 

 

46. When all options are selected, click the OK button. 
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47. The report will open. The report can be printed from this screen by clicking the Printer button in 

the top left corner of the screen. Close the screen by clicking the X in the top right corner. 

 

 

 
 

 

48. When the report is closed, a Save As screen will open allowing the user to save the report to a 

desired location. Click Save when ready. 
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 Custom Consolidation 

 

 
 

 

49. The third option on the Report Tools menu in the Reports area is Custom Consolidate. 

 

 

               
 

 

A. Set the From Date and To Date by clicking on the month, day, or year to change it or by 

clicking the down arrows  at the end of the date boxes to open the calendar at the 

right. Click on the day on the calendar to select it. Move the calendar forward or back by 

using the arrows on the top left and right corners of the calendars.  

 

 

 
 

 

B. Pick either Show Store Name, which will display the name of the store on the report or 

Show Machine ID will display the machine id on the report. 
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C. On the left, pick the report from the Report Type drop down menu. The report type 

picked changes the options on the rest of the screen. 

D. On the right, pick the machine for the Machine Type drop down menu. 

 

 

           
 

 

E. Pick the Poll Type above left. 

F. Next, pick a Poll Area. 

 

 

 
 

 

G. With the Report Type picked as Transaction, the Machine list button is available.  
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H. Clicking the Machine List button opens the screen above. Use the Select All button to 

check off all machines in the list. The Clear All button will uncheck all checked off 

machines. 

I. When the appropriate machines are selected, click on the OK button or Cancel to cancel 

any changes and to close the window. 

 

 

 
 

 

J. The Transaction File button opens the screen above, which allows the user to select all 

transaction items with the Select All or uncheck all items with the Clear All button. Click 

OK when the appropriate selections are made, or Cancel to cancel any changes and 

close the screen. 
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K. The Retrieve Setup button opens a Select Setup screen to allow the user to pick a 

previously saved setup. Select a setup from the list then click OK. 

 

 

 
 

 

L. The Save Setup button allows the user to save a report consolidation setup for future 

use or update a saved setup. It opens the Enter Setup Name screen. Type in a name for 

the setup and then click OK. 
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M. To delete a previously save Setup, click the Delete Setup button and pick from the list of 

setup to delete. Click OK. 

 

 

 
 

 

N. When ready, click the View Report button and a progress bar appears automatically. It 

will close when the report is processed and open. 
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O. A progress bar will appear and close automatically when the report opens. 

 

 

 
 

 

P. The report will open automatically. 
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Q. This is the same report with Zero Skip checked. 

 

 

 
 

 

The tools on top portion of the report screen can be used to customize the report. 

 

 Zero Skip Removes the zeros from the report data. 

 Zero Sellers Removes all but the zero selling items. 

 Display Count  Controls how many stores are displayed on one view screen. 

 Move to First Record   Returns the cursor to the top record. 

 Move Back a record   Moves the cursor up one record. 

 Move Down a Record   Moves the cursor down one record. 

 Move to Last Record   Moves the cursor to the last record in the report. 

 Filter Records button   This allows the user to filter the records in the listing to 

their specifications. Clicking this button brings up the Filter by Field selection window from which users 

can custom define their filtering options. An overview on filtering is available in the Help Files under 

Filtering Features. 

 

 

 
 

 

 Export Report Opens the Table Export screen to allow users to choose the fields and other 

 options to export. For more information on export using the Table Export screen, see the Help 

 Files:  .txt – Exporting and Importing. 

 

 Print  Prints the report. 
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 Close  Closes the Report View screen. 

 Previous Moves the viewable portion of the report back a page. 

 Next  Moves the viewable portion of the report ahead a page. 

 

 

 
 

 

50. To close the Report View screen when finished, click the Close button near the top of the screen. 

 

 TLog Export 

 

 
 

 

51. To use the TLog Export feature in the Reports area, select a T-Log Report from the grid by 

highlighting it. To make it faster to find the TLog Reports in the list of reports in the grid above, 

click on the column heading Report Name. This will sort the reports in alphabetical order. From 

the Report Tools menu, pick TLog Export. 
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52. When TLog Export is picked from the Report Tools menu, the screen above opens. Pick the 

appropriate options and click OK to process the export. 

 

 TLog Export Options 

 

 
 

 

The TLog Export Options screen can be opened from the Report Tools menu. 
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This will open with the last saved settings. If more information is needed on this feature, please request 

more documentation. 


